
Epilog Zing 24
Laser Cutter

Introduction:
The Maker Studio’s laser cutter is an Epilog Zing 24. It is designed to engrave a wide variety 
of materials, and is capable of cutting through several varieties as well. Typical materials 
include wood, glass, coated metals, and acrylic.
It uses CorelDraw as the vector program to execute projects with, though other vector 
programs can be used to create designs.
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Overview of Laser Cutting
Parts of the Laser

Rotary table and extraction unit not pictured

Control Panel
• Start (green): This will begin engraving your 

design. It also acts occasionally as a 
con�rmation button.

• Pause (red): This will pause a job in progress 
giving you the opportunity to assess your 
design.

0. Return: This button is used to return the laser to 
its home positions or go back within a menu.

1. Speed adjust: This button allows you to adjust 
the speed of a raster job currently in progress.

2. Power adjust: Similarly, this adjusts the power 
of the raster job currently in progress.

3. Up: Navigates up during menus and raises the 
print bed during focusing.

4. Down: Navigates down during menus and 
lowers the print bed during focusing.

5. Focus: This button starts the process of focusing 
the laser by allowing you to raise or lower the 
bed.

6. Job button: This lets you browse through any 
submitted jobs currently in memory.

7. Red dot: This turns on the red dot laser. Useful 
for center engraving and testing cut lines. 
Unused during actual engraving.

8. X/Y Unlock: Unlocks the laser arm and head for re-positioning home.
9. Settings: This brings up the settings for the machine and allows for diagnostics.

Power Switch

Control Panel

Front Panel

Fan Switch

Lid

Level

Print Bed
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Operating the laser
Setting up the machine
The following steps are to set up for a standard �at object engraving and cutting procedure. 
If you are engraving a cylindrial object, skip to Rotary Engraving later in the guide.

1. Check the bed of the laser. You can engrave an object directly on the print bed or with 
the vector grid attachment.

2. If you intend to cut through a piece of material, ensure the vector grid is installed. If it 
is already installed, skip ahead to step 3. If it is not, follow the next steps.
a. On the bottom of the vector grid are a set of tabs. In the rulers on the inside of the 

laser bed are some holes. Align the tabs with the holes in the ruler. Ensure the tabs sit 
inside the holes and the vector grid doesn’t slide around.

3. Place your material in the top left corner of the print area.  If your object doesn’t have 
a sharp corner, place it as far to the top and left as possible.
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4. Turn on the machine using the switch on the right side. Wait for the machine to �nish 
booting up. The display on the control panel at the top will display “Job:” when it is ready 
to use.

5. Press button 5 on the control panel to begin the focusing process. On the laser arm, 
swing down the spring rod so that it hangs freely. Use the up and down arrows on the 
control panel to raise or lower the bed so that the tip of the spring rod just barely touches 
the top of your material.

6. Once the laser has been focused, swing the rod back up and clip it in place, then press 
button 0 to return the laser arm to its resting location.

Engraving and cutting �at stock
1. In Corel Draw, set up your page to be the size of the object you’re working with. 
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2. Place your design where you would like for it to appear on the object. (For example, if 
centered to the middle of your page, then it would be centered to the middle of your 
item as long as their dimensions were matched.)

3. If you intend to cut through the material, set the vector path of your cut line to a 
hairline thickness.

4. Print your object by clicking on the printer icon on the toolbar or going to File > Print. 
On the print dialog, press Print.

5. The Epilog Dashboard will now open with your object. By default it will block off a 
region of the bed that matches the document size you created in Corel and your design 
should be placed where it was.
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a. Note, nothing in the greyed out region will print even if something appears there. 
However this region can be expanded if you change your mind on the page size or 
you need to adjust the placement later on. To do this, drag the pink border lines in 
include more in the usable area.

6. The design will enter in exactly as it was placed on the project in Corel Draw. If 
however you wish to make any adjustments to size, position, or rotation you can do that at 
this stage by clicking on the object and adjusting the points in the corners.

7. On the right side are your processes. This is where the software analyzes your design 
and separates out any engraving from cutting. There are two folder icons on each 
process, and the top one will pull up the material catalog.
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8. Select the material you’re using and the type of engraving or cutting you wish to do. 
You will have to set this for both the engraving and vector settings.

9. You can also rename your project in the top left which may be useful in later steps but 
is optional for the actual process.

10. Once you are satis�ed with the placement of your design, and you’ve applied the 

settings to your processes, click Print in the bottom right of the screen.
11. On the screen of the laser you should see your project appear at the top of the list.

12. Press the play button on the control panel and your project will begin.

13. The project will move through the process list from start to �nish. If it doesn’t have one 
or the other, it simply skips that step in the process.

14. Once you are done with your project on the computer, click the Discard button in the 
bottom right of the screen to close out the project.

Laser - Zing - 6



Rotary Engraving
1. Remove the vector grid if it is currently in the machine.
2. Lower the print bed by pressing button 5 and then holding down until it has a few 

inches of room between the bed and the laser arm. This will ensure you have adequate 
space for the following steps. Do this, then turn off the laser.

3. Add the rotary table to the laser’s print bed. This must be done while the laser is 
turned off. Place the rotary table inside the rulers on the print bed and then plug the 
cable into the port on the left side of the inside of the laser.

4. Measure the object you intend to engrave on both the horizontal and vertical sides. 
Write these down to remember.

5. Place your object on top of the rollers of the rotary table. If your object does not �t on 
both sets, pinch the levers on the right hand side and slide that roller set left or right so 
that your object does �t.
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a. Note, sometimes there is a pinch roller on the left side. This can help with rotation 
sometimes, but can get in the way depending on the orientation of the glass. If it is 
present, press the left side to open it, and put the lip under the roller.

6. Place the level on your object and use the wheel to raise or lower the right side so that 
your object is level. If your object is particularly rounded without much of a �at side, try 
and locate the �attest area and use that.

7. Turn on the machine using the switch on the right side. Wait for the machine to �nish 
booting up. The display on the control panel at the top will display “Job:” when it is ready 
to use.

8. Press button 5 on the control panel to begin the focusing process. On the laser arm, 
swing down the spring rod so that it hangs freely. Use the up and down arrows on the 
control panel to raise or lower the bed so that the tip of the spring rod just barely touches 
the top of your material.
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9. We now need to adjust the home location to de�ne a center point for the design. On 
the control panel, press buttons 7 and 8. This will turn on the red dot laser and unlock the 
laser head. Gently grip the belt inside the laser arm and pull it left and right to move the 
laser head down the side of your object. However try not to move the arm itself.

10. Depending on your object, you may or may not be able to see the red dot (like on 
glass for instance). You can apply blue tape to the side of your object or use a ruler to 
see where it’s located.

11. Move the red dot to where you want the center of your design to sit on the object. 
Once you’ve got that location set, press the green start button to lock the laser head in 
place again.

12. In Corel Draw, create a document where the width of the page is the height of your 
object and the height of the page is the width of your object. Then click OK.
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13. Set up your page with whatever design you’re doing. Then rotate the design 90 
degrees left or right so your design matches the orientation of the object in the machine.

14. Print your �le using the icon on the task bar or through File > Print. Press print on the 
dialog box that pops up.

15. You’ll then be taken to the Epilog Dashboard where your design will appear.

16. On the right hand side under Processes, click the upper folder icon to select the 
material you’re going to engrave on and apply those settings. If you are engraving at 
400 DPI or lower, choose a dithering option like Jarvis from the drop down.
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17. Click on the advanced tab on the top of the preview. In the left column you’ll choose 
your centering option. The speci�cs of these are listed in the section for Center Engraving.

18. Once these settings are applied you can press Print.
19. Your job should appear on the display on the laser.
20. Close the lid of the laser, turn on the �lter unit by pressing the power button on the 

front. Then press the start button on the control panel.

Center Engraving
Center engraving is a process by where you de�ne a home position for the laser. There are a 
few different approaches to center engraving and their placement is dependent on the 
design you want to use.
Typically you’ll be doing this in one of two ways. If you want to align your design to the 
center of your object, you’ll use the “Center-Center” option. This looks at the center of your 
design and places it at the red dot you de�ned using the XY unlock.

If you want to align the design a certain position away from an edge, say the rim of a cup, 
then you would use the “Left-Center” or “Right-Center” method depending on the orientation 
of your object. Here you would de�ne your red dot at the top of the design and your design 
will engrave from that point outwards.

Neither option is more correct than the other inherently, but you can utilize one over the other 
based on your intended outcome of the object.
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Performing a test cut
You can use a vector cut path to trace the outer bounds of your design around your object. 
This is a useful tool when checking whether your design will �t into an appropriate area on 
oddly shaped object. 

1. In Corel Draw, create a vector path using a shape or pen tool slightly outside the 
edges of your design. You want this to be bigger than your design, but not by much.

a. Note if your design has a cut line already, you can skip creating a second cut path and 
just use this design as your vector.

2. Print your job and open it in the Epilog Dashboard.
3. From the dashboard, set your engraving process, if any, to off. Set your vector speed 

to 100 and power to 0, then print your job.

4. Leaving the lid to the laser open, turn on the red dot laser using the touch screen.

5. Press play on the laser.
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6. Watch the path the red dot follows. If this is not where you intended your design to be, 
either move the material to match, or adjust the placement on the screen and print again.

a. Note: Center engraving can help with this process, but can also complicate the project 
some as well. See the section on Center Engraving for more information.

7. If you like the placement of your design, return to the Epilog Dashboard and remove 
the vector process (unless you were tracing with your actual cut line), turn your engraving 
process back on, and run your job as you normally would for the project.
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Advanced
Trace Bitmap
Objects that enter into CorelDraw may not be the best quality, or may have elements that are 
not ideal for the laser process. One solution to this can be the Trace Bitmap function. This 
process will scan the image and attempt to make a vector version of it. This can be useful to 
create unique cut lines from a piece of clipart in a JPG or PNG format, or to remove an 
unwanted background that would appear on the �nished piece.
Note that the process can work very well, but the worse quality the image, or the more detail 
is in it, you may have less luck with the overall process. This will describe how to create an 
image using a simple piece of clip art. You may need to tweak and modify your design to get 
the best output.
1. With your image selected, click on “Trace Bitmap” on the toolbar. Under this you’ll look 

for Outline Trace and then select the most appropriate option. Detailed logo typically 
works when you’re unsure which to use.

2. This will then display a preview with your original image and with the vectorized version, 
along with some adjustment sliders.
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3. The sidebar gives you some sliders you can adjust. This allows for changes to detail, 
corner smoothing, and the overall smoothness of the design.

4. Under the Remove section, if you have any internal areas that haven’t had the 
background removed, choose “Color from entire image” to remove those.

5. It is recommended you check the box for “Delete original”, but it isn’t required and may 
be best left unchecked if you plan to try this process multiple times with different results.

6. If your image has a lot of colors, or even just appears with a few patches of color, you 
can click the Colors tab. This will show all the colors in the design. It is recommended you 
get to as few colors as you can manage for the process to simplify the overall design.

7. Once satis�ed with the process, you can click OK to get your �nished design.

Using Dockers
Dockers are the set of tools on the right sidebar of the screen in Corel. The library default 
includes �ve though there are many under Window > Dockers you can add for a variety of 
features. This section will cover the �ve we typically provide.

Laser - Zing - 15



Properties

This docker will give you the ability to modify a particular item. There are too many variables 
to cover in here, but the main items are desribed below. Here you have the ability to change 
the �ll of an object. You’ll most likely want to work in RGB for this process. Note that anything 
that is listed as R0,G0,B0 will engrave at full power and anything that is R255,G255,B255 
will be ignored in the �nal engraving.

You also get the ability to change the outline of an object. You can tweak the appearance of 
the outline by how thick it is, what the line looks like, and where along the vector path the 
outline sits. Hairline is the outline setting used to cut through an object fully.

The other main area is the ability to modify the color and outline settings on text. While the 
font choices appear on the top toolbar, modifying the color and outline settings can be 
harder to manage and those settings are here under Properties.

Objects

The objects docker lets you see every piece of text, shape, and line you have within your 
design. These are organized into layers. It will put everything into just one layer unless you 
create a second layer.
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One of the most useful features within this is the ability to prevent a layer from printing. You 
can use this feature to create a layer �lled with guides to help you better set up your design 
without using them in the �nished printing. For instance, creating a circle to visualize where 
your design sits on a round coaster without engraving or cutting anything along the border of 
the coaster itself.

To do this, hover over an entire layer and click the printer so that it becomes crossed out.

Align and Distribute

Align and Distribute are two very useful features that let you better arrange your objects. The 
top section shows the ability to arrange objects by the left, center, right, top, middle, or 
bottom of all the selected objects.

The next section down details how they will align to each other. These will align them to each 
other, to the edges of the page, to the center of the page, along a grid, or to a speci�c point 
you specify on the page.

Distribute lets you space your objects in relation to each other either along their edges, 
centers or the spacing between the objects themselves.

The second section allows you to distribute them either according to the bounding edges of 
the outer most selected area, across the entire page itself, or with a speci�ed distance 
between the objects.

Shape

Shape is used to connect different pieces together to make one solid object. There is a docker 
for this giving you a drop down menu of features.

For a quick action, these tools are also on the toolbar when more than one object is selected.
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These are most commonly used to merge shapes together into one object, but also are used to 
cut one object out of another to create a hole.

Step and Repeat

Step and repeat is similar to distribute except where distribute moves around already 
created objects, step and repeat creates the objects as well as distributes them in one action.

You can distribute either horizontally or vertically, or both together. The distance listed is the 
gap between each item and can usually be set as low as .125”. If you just want to go in one 
direction, set the direction you don't want to move to “No offset.”

Color Mapping
One useful feature of the laser system is called color mapping. This is where you can apply 
different settings to differently colored items in your design. Perhaps you want one part of 
the design to engrave deeper than another, or maybe you want to score one cut line and use 
another to also cut through the material.
For this process in Corel Draw you’ll need to apply different colors to the different parts you 
want to treat differently. For instance in this example, there are two hairlines.

Without color mapping these would both cut through the material. But with color mapping we 
can set the one line to score into the surface while the other cuts through it.

1. After sending your project to print, click on the process you wish to split up.
2. Click on the “Split by: Color” option and your project should split into parts for each 

color.

Laser - Zing - 18



3. You can merge these back together should you need to by clicking “Merge with:” and 
selecting the appropriate option.

4. From here you can apply any amount of settings to your multiple processes either by 
importing a material type or by manually applying settings.

5. Print your job as normal.
6. Do note, that the laser will perform the job from the top down in the processes menu. 

It’s advised that whatever process is going to cut through the material completely be 
reserved for the last position just in case any part of it were to shift after being cut out.

Dithering
When engraving with a lower DPI or with photos, it’s best to use an image dithering option 
found under the raster settings. Dithering is the dot pattern produced by the laser. This can 
affect the overall look. For clip art and single color graphics, standard is �ne. Standard 
produces a fairly uniform dot pattern over the image which may not be desired with a photo. 
However, when engraving a photo or an icon with a lot of variable grays, other options like 
Jarvis can be preferred. Jarvis is an all around good option for photo engraving.
These are the various options and what they do.
• Standard - The default for most text and clip art 

applications at 500 DPI.
• Floyd-Steinberg - Has a wave like pattern to it that 

can be ideal for photos with a lot of detail.
• Jarvis - A good general use option for photographs.
• Stucki - A similar pattern to Jarvis that is nearly identical in outcome.
• Bayer - Produces a cross hatching pattern which is lower resolution but very stylized.
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Testing new materials
When using a new material that is not 
found in the materials list, or if you 
want to modify an established setting 
for a different effect, �rst check with 
Maker Studio staff to see if they have 
experience with that material. If not, 
follow these steps to �nd the right 
settings. This guide can also be used 
to modify the settings of an existing 
known material for personal 
preferences.
1. Choose a material from the chart that seems similar to your object, either in thickness, 

density, or stiffness. Use these settings as a baseline.
2. In CorelDraw, add a small bit of text to a design if you’re �nding engraving settings and 

a small rectangle if you’re �nding cutting settings. You will engrave or cut this design in 
multiple times while experimenting with settings. It can be helpful to engrave in the 
settings you used so you can reference and compare to past experiments.

3. Engrave this design in using the settings from your similar material. After the job is 
complete, examine your material and see if it had the desired effect. If not, adjust 
settings and try again. Even if it looks good the �rst time, try a couple variations to see if 
you can really get it looking great.

4. When adjusting settings, if you want the design to engrave more, increase the power 
and/or decrease speed. If you want to engrave less, increase speed and/or decrease 
power. Similarly, if your design didn’t cut all the way through, increase the power and/or 
decrease speed. If your design cut through but perhaps burned too much of your edge 
away, increase speed and/or decrease power.

5. Repeat this process multiple times until you �nd a good balance between speed and 
power.

6. If this is a brand new material, write down the settings and provide them to the Maker 
Studio staff to update our materials catalog.
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Metal shear/Corner rounder
The laser is incapable of cutting through metal. For that reason, we have a metal shear that 
can cut thin metals along straight lines. When cutting metal with the shear, do the best you can 
to maximize the size of the scrap cut off by cutting in a way that would save the largest sizes 
of metal before cutting small pieces off.

1. Raise the arm of the metal shear and place the sheet of metal on the bed against the 
ruler.

2. Slide the sheet under the blade and align the edge of your design with the edge of 
the bed.

3. Give consistent pressure as you push the arm of the metal shear down to cut through 
the metal.
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4. Repeat on all four sides.
5. If desired, we can round the corners with a punch.
a. Place your cut metal into the corner punch. Ensure your design is pressed back as far as 

it will go on both sides of the die punch.

b. Press down on the handle.

c. Repeat until all corners have been rounded.
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For Staff Use
Cleaning
There are two main areas that need cleaned on the laser, the mirrors and the vector grid.

Vector Grid cleaning
1. Remove the vector grid from the laser bed.

2. Unscrew the two green thumb screws on the front panel of the vector grid.
3. Empty the contents of the vector grid into the trash.

4. Replace the front panel and screw in the two thumb screws until snug.
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Mirrors

1. Turn off the laser to begin the cleaning process.
2. Pull the laser arm out to the center of the bed. Slide the laser head over by gently 

pulling on the belt.

3. On the back of the laser head is a round disc, the mirror. Gently unscrew this and 
remove it. Take a lens cleaning wipe and lightly clean the mirror in a circular pattern.

4. Once the mirror is cleaned, it can be placed back into the laser head and screwed in 
until snug.

5. On the bottom of the laser head is another round disc, this time the lens. Gently 
unscrew this as well and remove it. Clean this the same way as you do the mirror. This gets 
dirtier than the mirror, so it may take a couple of wipes to get it truly clean.

6. Once the lens is also clean, screw it back into the bottom of the laser head until snug.
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